“Lokal 300" Operating Instructions

Version 1.0.0.2 and higher

Lokal 300 Printmonitor




Contents

“Lokal 300“ Operating INStruCtionsS........c.ocevviiivieiinneeeiiineeeens 1
Version 1.0.0.2 and higNEr.........ooiiiiiiiiiiiiieeeeeeeeeeee e 1
CONT NS e 2
List of HIUSTrations ......cooviiiiii e, 4
Contact Details ........ooeiiiiiii 6
L INtrOdUCTION....ccie e 7
1.1 General INFOIMALION .......uuuiiiiii e 7
1.2 OVerview Of ChaplerS......coooiiiiiiiiii e e e e e eaaanan 7

2 Programme DeSigN ......ccuiiiiiiiiie e 8
2.1 IMIBINUS ..ottt e ettt e et e e et e e et e e e e e ena e e eeraa e 8
2.2 WINAOWS ...ttt s e e e e e e ettt a e e e e e e e e e e tasn e e e e e e e eeeennnnnnaaeeens 9
P2 R T = TR = 1 [ SR 10
A2 B I - To | = 1o 4 S 1= o1 1[0 o U 11

3 Functionality of the Menu ...........cccooeiiiii i, 14
0t I 1 = PP 14
3.1.10PENING @ FIlE e 14
3.1.2.SAVING @ FIle..cciiiiiiiiiiiiiiiiiieeeeeeeeeeeee e 15
3.1.3 CUSIOMEN'S AAAIESS......ceiiiiiiiiiieieeeeee e 15

B T 00 o 1] o U 17
3.1.5 Quitting the Programime .............ciiiiiiiiiieeeee e e 19

32 SBHINGS oo 19
T N =g [0 [ U = To [T PPPTT 20
3.2.2 COMMUNICATION. ...ciiiiiiiiiiiiiiiiiieee ettt ettt e e e e e e e e e eeees 22
3.2.3 Service SUPPIIEr'S AQArESS........uuiiii et 23



3.3.2 INfOrmation WINAOW.........ccoiiiiiiiiiiieee et 24

4 Window Functionality .......ccccooovviiiiiiiiiic e 25
R D v BT =T o 1o o PP PPPPPPPPPPPI 25
A B IT- Vo [ = 1 S T=Tod 1 o] o PP 26
4.2.1 Functions of the Diagram SecCtion...............ceeeiiiiieiiiiieiccicn e, 26
4.2.2 Scaling UP the Map.....ccoooeeiiiieece e 27
4.2.3 Scaling dowWn the Map .....coooiiiiiiiiie e 28
4.2.4 AUTO-AAJUSTMENT ....ooiiiiiiiiiiiiiiiiieeeee ettt 28

4.3 Reading out the Lokal 300 Data.........cccoeeeeeiiiiiiiiiiiie e 29



List of lllustrations

lllustration 2-1:
[llustration 2-2:
[llustration 2-3:
[llustration 2-4:
lllustration 2-5:
[llustration 2-6:
[llustration 2-7:
[llustration 2-8:
lllustration 3-1:
[llustration 3-2:
[llustration 3-3:
[llustration 3-4:
[llustration 3-5:
[llustration 3-6:
[llustration 3-7:
lllustration 3-8:
[llustration 3-9:

[llustration 3-10:
lllustration 3-11:
lllustration 3-12:
[llustration 3-13:
[llustration 3-14:
[llustration 3-15:

[llustration 4-1:
lllustration 4-2:
lllustration 4-3:
[llustration 4-4:
[llustration 4-5:
lllustration 4-6:
lllustration 4-7:
[llustration 4-8:
[llustration 4-9:
lllustration 4-10

FIE MENU Lo 8
SEHINGS MENU covviiiiiiii e e e e e e e e e e eeanne 9
HEIP MEBNU...eiiii e 9
Y= T YT o o o 1Y PP 10
D2 U= IR o o ] o PP 11
GraphiCal VIEW ......uuiiie e e e e e e eeanes 11
Graphical display of the difference in propagation times ........ 12
Graphical display of coherence.......ccccccceeiiiiiiiiiiiiii s 13
OpeNiNg afile .o 14
Opening a File dialogUe..........ccoeiiieiiiiiiicie e 15
SaVING @Il i 15
CUSTOMEr'S AAAIESS ...t eeaees 16
Entering the customer’s address .........ccceevveiiiiiiiiiiiiiiiiiiiiiiiiienns 16
Print-out showing the customer’s address ..........ccccevvvvvvvvnnnnn. 17
PIINEING oo e 18
PrINT PrEVIEW ..o 18
Print PrevVieW MENU.........iiiei et e e 19

LanQUage MENU ....coevuiiiiiiiiiiee e e e e e e e e e ea e eaaeees 20

COoM-POrt SEINGS .uii i 22

Service Supplier's Address Menu .........cccceeveeeeiieeeiiiiiiineee e, 23

Service Supplier's Address Window ..........ccoceeeieiniiiiininnnnnns 23

Service Supplier’'s Address print-Out ..........cccceevvvviiiiiiiieeeeeee, 24

INfOrmMation WiNAOW ........ccoovviiiiiiiiiiiiiiiiiiiiiieieeeeeeeeeeeeeeeeeeeeeeeeeee 24
Data SeCtion WINUOW ...........uuuuuuriiiiiiiiiiiiiiiieriieiiieeeeeeeee. 25
(@ oJL=Tox i 0 0] o 11 PRSPPI 27
Zooming in ObJECT MEeNU.......coooiiiiiiiiiii 27
Scaling up with the mouUSe......ccoooee i 28
Zooming out ObjeCct MeNU ... 28
Auto-adjustment object menu ..........ccccoeiii i 29
Saving/loading a measuremMent ... 30
Selecting a measUremMEeNt......ccoiii e iiieeee e e 30
Loading a MeasuremMeNt..........oovvuiiiiiiiieeeeeeeeeeee e 30
s Printing out @ measurement.........oooviiiiiiiiiie e 31

-4 -



[llustration 4-11: Printing out a measurement

[llustration 4-12: Measurement displayed by the programme ............cccccoeeee.



Contact Detalls

Firma
F.A.S.T. GmbH
Boessingerstr. 36

D-74243 Langenbeutingen

Contact: Mr Tilo Behrmann

Tel: +49 - 7946-92100-25
Fax: +49 - 7946-7153
E-Mail: info@fastgmbh.de

Behrmann@fastgmbh.de

Web: www.fastgmbh.de



mailto:info@fastgmbh.de
mailto:Behrmann@fastgmbh.de
http://www.fastgmbh.de/

1 Introduction

1.1 General Information

The “Lokal 300 Printmonitor® programme is to read out and to display correlator
measurements. The measurement-related recorded data is evaluated, transmitted to the
correlator programme, and clearly displayed in a table and diagram. The measurements
transmitted can be printed out and saved as a report once they have been received by the

programme.

1.2 Overview of Chapters

These Operating Instructions comprises 4 chapters.

After this Introduction, chapter 2 is to give an overview of the various functions and

components of the programme.

Chapter 3 is to provide information on the single menu levels with the particular sub-menus

and on the settings required to read out the data.

Finally, chapter 4 is to explain the functionalities of the windows of the programme. Chapter

4.3 contains the single steps required to read out the data.



2 Programme Design

The following chapter offers an overview of the various functions, the design, and the most
important components of the programme. Both the menu levels and the window sections of

the programme will be presented and explained in detail.

2.1 Menus

In order to control the individual functions of the programme, you have several menu options
available. When the programme has been booted, the menu bar will offer three menu levels:

“File", ”Settings”, and "Help*.

In the “Files” menu level you will find all relevant information required to open an already
existing “Lokal 300 Data File* and to save a read-out measurement as "Lokal 300
Data File*. Furthermore, the programme offers you the option to assign a customer’s
address, to print out data which has already been read out, or to quit the programme through

this menu. Hlustration 2-1 below shows the extended ”Fi 1e*“ menu.

| File
Jpen Skrg+0
Save Skrg+5

Consumer adress
Print Skrg+P

Exit Sktrg+E

llustration 2-1: File menu

The “Settings” menu level is used to change some of the features of the programme such as
the language, which can be adapted to the customer’s requirements. Furthermore, the
configuration of the serial interface can be changed in this menu level, and the service
supplier’s address (to appear on every report) can also be entered here. The expanded

“Settings” menu is illustrated below (see Illustration 2-2).




Settings

Language F 2Erman
Communication & English

Service adress Fremnch

Ttaliam
Spanish
Porfuguese
Simedish
[orwegian
[amist
Polish

Fussian Settings Settings

Chinese Language ] | Language b

(Zzech Communicakion k Serial | Cormrmunication k

Slowenian Service adress Service adress

Illustration 2-2: Settings menu

The “Help“ menu provides you with information on the programme itself as well as on the
channels such as homepage, telephone, and fax number via which you can contact F.A.S.T.
GmbH.

A Lokal 300 Printmonitg
File Settings |He||:|

| Info |

llustration 2-3: Help menu

For detailed information and descriptions concerning the File, Settings and Help menu

levels as well as concerning the corresponding functions, please refer to Chapter 3.

2.2 Windows

The “Lokal 300 Printmonitor® programme features one main window which can be
divided into two sections: the data section and the diagram section. The data section (shown
in Hlustration 2-4 on the left hand side) displays the parameters of a measurement procedure
listed in alphanumeric order. The diagram section on the right hand side displays the results of

the correlation and the coherence in graphical form.
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B Lokal 300 Printmonitor 1.0.0.3 B =]

File Settings Help

-9.32ms
Drate: 07,04, 2009
Time: 14:39:00
Low-pass filter: 2000 Hz
High-pass Filker: 450 Hz
Time-Frame: 320 ms
Time delay:
oance b gl Data Section L 1 m_a ] Diagram Section k‘.—.-—
44 2000 Hz
Distance of B! O.5E m
Material Diameters  Diskan, Wd[my'=s]
Dukk. Guss + Zement 65 mm 1705 m 1140 mis

Hlustration 2-4: Main window

2.2.1 Data Section

The data section of the “Lokal 300 programme displays the parameters and settings of the
particular measurement (see Illustration 2-5). The particular parameters and settings are
briefly described below.

The initial information on the overview is the date and the time of the measurement. Then the
set high-pass and low-pass filters are indicated in hertz [Hz], followed by the time-frame of
the measurement as well as the time delay in [ms]. The time-frame reveals the time the signal
required to travel from the middle of the section to the receivers. The time delay indicates the
time the leakage-borne noise required to travel from the fracture spot or crack to pick-up A in

comparison to the time the noise required to reach pick-up B.

The following two points indicate the distance between the leakage and the two pick-ups A
and B in [metre]. At the bottom of the data section, the underlying material properties are
displayed. Up to four definitions for one measurement procedure can be applied. The
indicated information (properties) describe the material of the pipeline section, the pipe

diameter, the length in [metre], and the sonic velocity on the pipeline in [m/s].
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A Lokal 300 Printmonitor 1.0.0.3
File Settings Help

Date: 07.04.2009

Time: 14:39:00

Low-pass filker: 2000 Hz

High-pass filker: 450 Hz

Time-Frame: 320 ms

Time delay: -9.32 ms

Distance of A: 79.94 m

Cistance of B: 90,56 m

Material Diameters Distan. wd[mjs]

Cukk, Guss + Zement  BS mm 170.5m 1140 mé=

llustration 2-5: Data Section

2.2.2 Diagram Section

In the upper part of the diagram section, the results of the correlation and the peak of the
correlation function are displayed. In the lower part, the coherence representing the entire
portion of the pipeline-borne noise picked up at both receivers is displayed (see Illustration
2-6).

-26. 49 ms

Coherence

llustration 2-6: Graphical view
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The correlation function determines the difference in propagation times generated by two
signals which reach the pick-ups in different times. This difference in propagation times is
displayed with a peak in the correlation function (see Illustration 2-7). In the below example,
the difference in propagation times reveals that the leakage is located 26.99 ms closer to
receiver A than to receiver B.

Eﬁi ms

Illustration 2-7: Graphical display of the difference in propagation times

The coherence indicates the common portion o the pipeline-borne noise (pipe fracture, water
meter) received by the two pick-ups at measurement spot A and measurement spot B with the
current high-pass and low-pass filter settings. Disturbing noise such as cars, people,
conversations, etc. picked up by the two sensors will reduce the coherence as such noises

envelop the common pipeline-borne noise.

The coherence is displayed by means of blue bars, with the height of a bar abstracting the
level of noise coincidence at measurement spot A and measurement spot B. Furthermore, the
position of the bar in the diagram reveals an estimate concerning the corresponding
frequency. The more the bar is positioned to the right, the higher is the frequency the bar
represents. The coherence can be used as decision guidance for the setting of the digital
filters. The digital filters set by the operator are displayed with vertical red lines in the
coherence diagram. The corresponding hertz value is indicated at the upper tip of the

particular line (= filter) (see Illustration 2-8).
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Illustration 2-8: Graphical display of coherence
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3 Functionality of the Menu

Chapter 3 is to present in detail the single menu levels and the particular sub-menus. First, the
functions related to the “File” menu are explained in Chapter 3.1. Chapter 3.2 then deals

with the “Settings” menu, and Chapter 3.3 provides information on the "He Ip*“ menu level.

3.1 File

In the “Fi le" menu, you can “Open* or “Save" a "Lokal 300 Data File* and also enter
the customer’s address to be printed on the report(s). In addition, this menu level offers a
number of print functions as well as the function to quit the programme. The menu levels are

described in detail in the following sections.

3.1.1 Opening a File

If you want to open an already existing file, click on “File” -> ”Open* or press the key

combination "STRG* + “0*. lllustration 3-1 below is to visualize the menu.

CIpEn

Save Skrg+5

Consumer adress
Print Strg+P

Exit Strg+E

Ilustration 3-1: Opening a file

Pressing on "Open* makes a file selection dialogue appear on the screen where you can select
the desired file (see Illustration 3-2). Open the folder of the project containing the “Lokal
300 Data File” and choose the file you intend to open. Then click on “Open® to open the

desired file, which will then be displayed.
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Suchen in: ||j Lokal300 i'| @| |§| iE| BE E_:!

I tang

b

Datetname: | |

Dateityp: |Lokal 300 Data File | . !
| Offnen || Abbrechen |

Ilustration 3-2: Opening a File dialogue

Once the file has been opened, the data section will be filled with the values related to the
particular measurement, and the diagram section shows the results of the correlation in the

upper part and the coherence in the lower part.

3.1.2 Saving a File

If you intend to save the read-out values in a file, click on "File* -> "Save". A “Save
File Dialogue” will appear similar to the one shown in Illustration 3-2 above, where you
can select the path for the particular file. The programme automatically suggests a file name,
which can be seen in the "File Name* window. The name consists of the word
“Measurement” and of the date and time of the measurement, e.g. "Measurement-

21_06_2006-08_43_00. 1df*.

Open Skeg+D
Skrg+5

Consumer adress
Prink Skrg+P

Exit Skrg+E

llustration 3-3: Saving a file

3.1.3 Customer’s address

If the measurement was carried out on behalf of a customer, you can assign the customer’s
address on this menu level. The customer’s address will then be shown on the print-out. Click

on “File” ->"Customer’s address” (see lllustration 3-4 below).
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Cpen Skrg+O
Save Skrg+s
Consumer adress

Primk Skrg+P
Exit Skrg+E

llustration 3-4: Customer’s address

A window will appear where you can enter the particular data. After you have entered the
particulars, click on “Save“ and the data entered into the boxes will be accepted (see
[llustration 3-5).

x

T0O

street

Zip code

City

Save i_ancel

Illustration 3-5: Entering the customer’s address

If you click on “Chancel*, the window will be closed and the entered data will be deleted,
i.e. the entered data will not be accepted by the programme. If the boxes have not been filled

with the particulars, the print-out (reports) will not show the customer’s address.
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A Drucken

<> &4

a8

Showing the
ﬁ:,, Test < customer’s address on
Strasse N i
00000 ORT the print-out

Db 21.06.2005 2eit: 0g:43:00
Tiefoass: 00 H= Hoohpass! 1 Hz
Zeitfenster: 1280 m= Zeitverzdgenag:  -26,99 ms
Entfemung war A 5773 m Entemuny vor B: G407 m

Wabedal Dwmhwesser Limge 1Al fers ]
FE 'Weich 150 mm 1218 m 235 mis

Kuorelation

Kohdrenz

Ilustration 3-6: Print-out showing the customer’s address

If you have assigned a customer’s address (see Illustration 3-4 above), this address will be

shown on the print preview and on the print-out in the address box (see example in Illustration

3-6). If you want to delete the customer’s address again, just open the entry window for the

customer’s address (see Illustration 3-4) and delete the particulars from the entry sections.

Then click on “Save* to make sure the particulars will not be shown on the print-out.

3.1.4 Printing

In order to print out a clearly arranged report containing the data and diagrams related to the

particular measurement procedures, click on “File” -> "Print“ and the currently displayed

measurement will be printed out (see Illustration 3-7 below).
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File
Cpen Skrg+O
Save Skrg+s

Consumer adress
Prink Skrg+P

Exit Skrg+E

llustration 3-7: Printing

A print preview will appear giving an overview of the report. Here you will find further menu

levels such as Scaling up / down or Paging. These menu levels are described below.

B Drucken
EIEYIRIEINEY Y
| =
S
sy | L
An
Test
a7 g 1 6 200 Zani- G e
Tafiss i HZ HOC RS 1mz
Dl e 124 ma el reTdpa Ty 25 SN S
ErdeTung rom A° ST,TIM ErdfeiTurg rov 5 B4 5T M
fadera’  INAT GRS sEr L Vi)
PE Walch 150 mp 1212m 2l5miE

romadadon

s
i,

KN Il I [*]

Hlustration 3-8: Print Preview

The button bar of the print preview contains the following menu levels: Print and Select
printer respectively, Setting up a page, Paging, and Zoom, which offer a number

of different functionalities as described below.
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I]ru::ken

SIRIRANLNEY

Hlustration 3-9: Print Preview menu

The magnifying function | @% ‘ ‘ @%‘ is to scale up or scale down the report in the print

preview mode.

<]

The arrow keys | /' make you go to the next/previous page if the report consists of

several pages.

The first printer symbol | = | takes you to the “Print* dialogue window. A new window
appears where you are requested to select any of the installed printers, to adjust the settings
for the desired paper format and the print-out quality, to determine the number of copies to be

printed out, and to start the printing process by clicking on "Print out".
=
The second printer symbol | = | leads you to the “Setting up the page“ dialogue

window. Here you are requested to select the desired paper format and the page format as well
as to set the margins for the print-out.

3.1.5 Quitting the Programme

If you want to leave the programme, click on “File” -> “Exit“ or use press the key

combination "STRG" + ”E“. As an alternative, you can also quit the programme by clicking on

the red X E|@|E|

3.2 Settings

The Settings menu level of the “Lokal 300 Printmonitor® programme is to assist you in
adjusting any programme-related settings such as language settings and communication
settings. In addition, you can also assign a service supplier’s address to be printed on the

report. The individual menu levels are described in detail in the below chapters.
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3.2.1 Language

In the menu “Settings” -> “Language” you can adapt any text-related features in the
programme to your national language. The programme supports up to nine languages, as
shown in Hllustration 3-10 below. As soon as the “Lokal 300 Printmonitor® programme
has been installed, German and English will be available as standard languages. These two
language packages are firmly implemented in the programme and cannot be deleted or

modified.

| Settings

Language k ZEFmMan
Communication k& English

Service adress French

IEaliamn
SEAnish
Fortuguese
Swedish
Maredgian
Damist
Palist
Russian
Chinese
(Zzech

Slovemian

Ilustration 3-10: Language menu

Consequently, you can select only German or English in the “Language” menu when the
programme has been installed. For the other seven languages, a separate language file has to
be created before these other languages can be activated. In order to ease this adaptation, the
programme creates a template of the language file during installation, which is located in the
”lang” folder. You will find this “lang” folder in the installation directory of the ”Lokal
300 Printmonitor® programme. If, for example, you have installed the programme at
“C:\Programmes”, the installation directory of the programme can be found at
”C:\Programmes\Lokal300“ and the template of the language file is located at

”C:\Programmes\Lokal300\lang"“.
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Once you have opened the *“lang“ folder, you will see the template called
”Sprache .properties®. This file can be opened and processed with the "Editor® or
“Wordpad* programmes. However, before you process the file, you will have to create a copy
of the “Prache.properties” file in the same folder as the template itself must not be
modified in order to avoid an error functions in the programme. Never change the template,

only modify the copied version of the file.

You can create a copy of the file by clicking once on the file with the left mouse key to
highlight the file. Then move the cursor across the highlighted file and press the right mouse
key. A so-called pop-up menu will open up where you have to click on the ”Copy* button
with the left mouse key. As a final step, the copy of the file has to be inserted into the same
folder. In order to do so, please go to the “Process* menu of the folder window and click on
“Insert”. You now should have another language file named “Copy of
Sprachen.properties* in the “lang” folder. This copy can now be adapted to the desired

language.

When you have completed the adaptation to the desired language, the name of the language
file has to be assigned for the programme so that the programme is capable of identifying and
loading this new file properly. So please rename the copy of your language file (“Copy of

Sprachen.properties*) in accordance with the following pattern shown below:

e French ->“Sprache_fr_FR._properties”
e Spanish -> “Sprache_es_ES.properties”
e Italian -> “Sprache_it_IT.properties”
e Danish -> “Sprache_da_DK.properties”

e Norwegian ->“Sprache_no_NO.properties”
e Swedish -> “Sprache_sv_SE._properties*
e Portuguese ->“Sprache_pt_PT.properties”
e Polnisch ->“Sprache_pl_PL_properties”
e Russisch ->“Sprache_ru_RU.properties”
e Chinesisch  ->“Sprache_zh_CN.properties”
e Tschechisch ->“Sprache_cs_CZ.properties”

e Slowenisch ->“Sprache_sl_SI _properties”
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3.2.2 Communication

Determine the mode of data transfer at “Settings” -> “Communication” via the serial

interface.
Reading-out via the serial interface

Before the data provided by the Lokal 300 correlator can be read out, the configuration for the
serial interface must be called. This can be done by clicking on “Settings" ->

"Communication“ ->"serial® inthe menu.

The “Com1* port will be selected by default. Select the appropriate Com-Port your correlator
has been connected to. Normally all other settings do not have to be changed. As soon as you
have set the appropriate Com-Port, adapt the setting(s) by clicking on “Save®. The
programme is now ready for operation and is awaiting the data sent by the correlator. As soon
as the data has been sent, the information displayed by of the programme is updated with the
information sent in by the correlator. Chapter 4.3 is to describe in which way the data is

transferred from the correlator to the programme.

Settings x|

_orn pork:

Baud: 9600 =]
Data bits: a |
Stop bits: 1 =]
Parity: none j
Flow cantral: nane j

Save Cancel

lllustration 3-11: Com-Port settings
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3.2.3 Service Supplier's Address

If you act as a service supplier, you have the option to assign a service supplier’s address
which will then be shown on the printed reports. In order to insert a service supplier’s address,

click on “Settings” -> "Service address” (see Illustration 3-12 below).

| Settings

Language b

_amnunication k

Service adress

Ilustration 3-12: Service Supplier’s Address menu

A dialogue window where you are requested to enter the particulars of the address will
appear. The entered data will be accepted and saved by clicking on the “Save* button. Click

on “Chancel” if you want to close the window and to reject the entered data.

x
To ﬂ
ntreet
Zip code
City
Save | Cancel |

Hlustration 3-13: Service Supplier’s Address window

If you want to delete the service supplier’s address from the report, open the input window for
the service supplier’s address and delete the particulars from the entry boxes. Then click on

“Save“ to finally delete the service supplier’s address.
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Drucken
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Dienstleistername
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Illustration 3-14: Service Supplier’s Address print-out
3.3 Help

3.3.1 Information Window

The Help menu offers an information menu level where the current version of the Lokal 300
Printmonitor software is indicated and where you will find some information on how to

contact us (see Ilustration 3-15).

Programminformationen

Programmwersion: 1.0.0.1

Firma: F.A.S.T. GmbhH

Bossingerstr. 36
D-74243 Langenhrettach

Telefon: 0049 (0)7946 92100 0
Internet: www.fastgmbh.de
OK

Hlustration 3-15: Information window
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4 Window Functionality

The following chapter is to provide an overview of the window functionalities of the
programme. Chapter 4.1 is to describe the “Data Section“ where the measurement
parameters used for a certain measurement procedure are displayed. Chapter 4.2 contains the

“Diagram Section* where the measurements are displayed graphically.

4.1 Data Section

The left-hand part of the main window shows a breakdown of the set measurement parameters
and of the read-out values related to the particular measurement procedures (see Illustration

4-1). The particular values are explained below.

B Lokal 300 Printmonitor 1.0.0.3
File Setktings Help

Date: 07,04, 2009

Time: 14:39:00

Low-pass Filker: 2000 Hz

High-pass Filter: 450 Hz

Tirme-Frame: 320 ms

Time delay: -9,32 ms

Distance of A; 79,94 m

Distance of B a0,56 m

Material Diamekers Distan, Sdlm)'s]

Dukk, Guss + Zement 5 mm 1705 m 1140 mfz

Ilustration 4-1: Data Section window
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The first two points indicate the date and the time when the measurement was carried out. The
next point shows the low-pass and high-pass filters set for the measurement. These filters can
be used to filter any disturbing noise. The next value shows the time frame as well as the time

delay of the measurement, indicated in [ms].

The time frame indicates the propagation time in [ms] the signal required to travel from the
middle of the section to pick-up A and pick-up B, which in the example shown in Illustration

4-1 above means a total of 320 ms in direction A and 320 ms in direction B.

The time delay indicates whether the leakage is located closer to pick-up A or closer to pick-
up B. A negative time delay means that the leakage spot is closer to pick-up A, and a positive
time delay reveals that the leakage spot is closer to pick-up B. The time delay reflects the
value AT which is used to determine the distance between the leakage spot to the pick-ups in

[metre]. This calculation is based on the sonic velocity related to the set material properties.

In addition, the lower part of the illustration shows the set material properties which constitute
the basis for the measurement (see Illustration 2-5). For measurements on sections featuring
different pipe and material properties, you have the option to set up to four different

properties, which will be used for the determination and calculation of the leakage.

4.2 Diagram Section

The values of the measurement are displayed graphically in the diagram section. The upper
part graphically shows the correlation, the lower part graphically shows the coherence
between the set high-pass and low-pass filters with a bar chart. The peak of the correlation
function is also graphically highlighted in the correlation programme. The functions available

are described below.

4.2.1 Functions of the Diagram Section

Both diagram windows offer functions to scale up and to scale down the diagrams and to
auto-adjust them. These functions are available through an object menu. Click on the right

mouse key when the cursor is on a diagram in order to call this object menu.
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Zaarm In ]
Zaarn 2uk ]

Auko Adjuskment

Ilustration 4-2: Object menu

4.2.2 Scaling up the Map

If you intend to scale up a diagram, call the object menu and click on the ”Zoom In* button.
You can now scale up either only the horizontal axis, or only the vertical axis, or both axes at

the same time.

Zoarm In b Bokh &Axis
Loan 2k b

Horizonkal &xis

Auto Adjustrent k Wertical Axis

llustration 4-3: Zooming in object menu

As an alternative, you can also scale up the graphic with the mouse. Press the left mouse key,
keep it pressed, and highlight the area you intend to scale up. When you release the left mouse

key, the area you selected will be displayed in a scaled-up way.
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Ilustration 4-4: Scaling up with the mouse

4.2.3 Scaling down the Map

If you intend to scale down a diagram, call the object menu and click on the ”"Zoom Out*
button. Here as well you can scale down either only the horizontal axis, or only the vertical

axis, or both axes at the same time.

Zoom In ]

Zoarn Sk Both &xis

futo Adjustrment k Horizonkal xis

Yertical fxis

Illustration 4-5: Zooming out object menu

4.2.4 Auto-adjustment

Click on “Auto Adjustment® in the object menu to call the auto-adjustment function. This
function is to fit the diagram in an optimal way into the window so that the visible area is as
large as possible. Here as well, you can choose which axis (horizontal, vertical, or both) you

wish to adjust.
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As an alternative, you can control the auto-adjust function with the mouse. In order to do so,
keep the mouse key pressed and draw the mouse a little bit to the left or to the top. When you
release the mouse key, the diagram will be auto-adjusted in both axes so that the visible area
Is as large as possible. The auto-adjustment function works only if the graphic has been scaled

up to a smaller section beforehand.

Zaar In ]
Zoarn Sk ]

Auto Adjuskment w Bokh Axis

Horizonkal Axis

Yertical Axis

Ilustration 4-6: Auto-adjustment object menu

4.3 Reading out the Lokal 300 Data

In order to read out the data provided by the Lokal 300, start the ”Lokal 300

Printmonitor" programme.
Hint:

Please note that the data cannot be read out with a customary serial cable. You need a
null modem cable with crossed data links or a null modem adapter for the serial cable in

order to be able to read out the data.

Please ensure that all settings for the serial interface have been made correctly and that the
appropriate Com-Port has been selected (see also Chapter 3.2.2). There is no need to make

further adjustments in the programme.

Connect the Lokal 300 with your PC and switch in on. Change to the “Save/Load
Measurement® category in the correlator (see point 1, Illustration 4-7) and confirm by

pressing the "E* key on the Lokal 300 device.
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Illustration 4-7: Saving/loading a measurement

The measurements saved in the correlator will be displayed now. Select the measurement (see
point 2, Illustration 4-8) you want to have displayed in the "Lokal 300 Printmonitor®

programme.

Ilustration 4-8: Selecting a measurement

When you have selected the desired measurement, go to "Load Measurement* (see point 3,

Illustration 4-9) and confirm by pressing the "E* key on the Lokal 300 device.

Ilustration 4-9: Loading a measurement
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When you have pressed the “E* key, the measurement you have selected will be loaded. Once
the measurement has been loaded, you are requested to select the "Print* function of the

Lokal 300 (see point 4, Illustration 4-10) and to confirm again by pressing the ”E* key.

Ilustration 4-10: Printing out a measurement

When you have pressed “E“ and thus confirmed the printing process for the particular
measurement, this measurement will be sent to the PC, and the ”“Lokal 300
Printmonitor®” programme will receive the data transmitted by the correlator. This data

will then be displayed.

Ilustration 4-11: Printing out a measurement

When you see the view as shown in Illustration 4-11, the data is being sent to the ”Lokal
300 Printmonitor® programme and is displayed by the programme as shown in

Ilustration 4-12 below.
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B Lokal 300 Printmonitor 1.0.0.3

File  Settings Help

=101

Date:

Tirme:

Tirne-frame:

Time delay:

Distance of A:

Distance of B:

Iaterial

Low-pass Filker:

High-pass filker:

DukE, Guss + Zement

07.04.2009

14:39:00

2000 Hz

450 Hz

320 ms

-9.32 ms

79,94 m

90,56 m

Diarneters  Diskan, Vd[mys]

53 mm 1705 m 1140 miz

450 Hz

-9.3

ms

2000 Hz

Ilustration 4-12: Measurement displayed by the programme
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